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Important Notice 

This guide is subject to the following conditions and restrictions: 
 

This User’s Guide provides documentation for the PowerTerm WBT product. • 
• 

• 

• 

• 

• 

The proprietary information belonging to Ericom® Software Ltd. is supplied solely for the 
purpose of assisting explicitly and properly authorized users of PowerTerm®. 
No part of its contents may be used for any other purpose, disclosed to any person or firm, or 
reproduced by any means, electronic and mechanical, without the express prior written 
permission of Ericom® Software Ltd. 
The text and graphics are for the purpose of illustration and reference only. The specifications 
on which they are based are subject to change without notice. 
The software describe in this document is furnished under a license agreement. The software 
may be used or copied only in accordance with the terms of that agreement. 
Information in this document is subject to change without notice. Corporate and individual 
names and data used in examples herein are fictitious unless otherwise noted. 

 
Copyright© 2003 Ericom® Software Ltd. 
 
Ericom® and PowerTerm® are registered trademarks of Ericom® Software Ltd., which may be 
registered in certain jurisdictions. Other company and brand, product and service names are 
trademarks or registered trademarks of their respective holders. 
 

   
 



 
  

3

Table of Contents 

IMPORTANT NOTICE 2 

TABLE OF CONTENTS 3 

ABOUT THIS GUIDE 8 

INTRODUCTION TO POWERTERM WBT 9 

What is PowerTerm WBT? 10 

PowerTerm WBT Features 11 

PowerTerm WBT Setup 12 
Working with a Single Terminal Connection 12 
Working with Multiple Terminal Connections 12 

Session Manager 13 
¾To activate all or some of the sessions  13 
¾To remove sessions from the activated list  13 

A Quick Guide Through PowerTerm WBT 14 
Step 1: Define a Connection Entry 14 
¾To define connection parameters  14 

Step 2: Connect to Host 15 
¾To connect to host  15 

Step 3: Work with a Host 15 
Step 4: Exit PowerTerm WBT 15 
¾To exit PowerTerm WBT  15 

THE POWERTERM WBT WORK AREA 16 

The PowerTerm WBT Window 17 

Menu Bar 18 

PowerTerm WBT Toolbar 19 
¾To display a description of what each button does  20 

Hot Keys 21 

   
 



 
  

4

Manipulating Desktop Components 22 
¾To open the floating menu  22 
¾To show/hide the Menu bar  22 
¾To show/hide the Soft buttons  22 
¾To show/hide the Status bar  22 
¾To show/hide the Power Pad  22 
¾To show/hide the History Scroll bar  22 
¾To change the display color of the PowerTerm WBT window  23 
¾To disable/enable underline  23 
¾To disable/enable blink  23 
¾To disable/enable host colors  23 

Selecting Text 24 
¾To select a word  24 
¾To select a block  24 
¾To select full lines  24 
¾To select a string  24 
¾To select the entire screen  24 
¾To select a menu entry  24 
¾To activate light pen support  24 

USING POWERTERM WBT 25 

Step 1: Create a Connection Entry 26 
¾To define connection parameters  26 

Connection Parameters 26 
Session Types 27 
¾To use an existing configuration  27 

Modifying Connection Parameters 27 
¾To modify connection parameters  27 

Customizing Settings 28 
¾To customize settings  28 

Import Terminal Setup from Host 28 
¾To import terminal setup from host  28 

Deleting a Connection 29 
¾To delete a connection  29 

Step 2: Setting Up Your Working Environment 30 
Mapping the Keyboard 30 
¾To map a PC key  30 
¾To assign a script command to a PC key  31 
¾To map combinations of keys that include Alt, Ctrl, and Shift  31 
¾To cancel a keyboard key definition  31 
¾To replace a PC key with another PC key  31 
¾To copy a PC key to another PC key  32 
¾To restore the default keyboard mapping of all mapped keys  32 

Saving and Opening Keyboard Mapping Settings 32 
¾To load the keyboard mapping settings  32 
¾To save keyboard mapping settings  32 

Programming the Power Pad 33 

   
 



 
  

5

¾To program the Power Pad  33 
¾To adjust the number of buttons in the Power Pad  34 

Saving and Opening Power Pad Settings 34 
¾To save your Power Pad settings  34 
¾To open predefined Power Pad settings  34 

Programming Soft Buttons 34 
¾To program Soft buttons  35 

Step 3: Defining Settings for a Terminal Emulation (Terminal Settings) 36 
General Property Page 36 
¾To define emulation parameters  36 

Display Property Page 38 
¾To define display parameters  39 

Keyboard Property Page 40 
¾To define keyboard parameters  40 

Printer Property Page 42 
¾To define printer parameters  42 

Advanced Printing 43 
Non 5250 printing 43 
¾To set values for non-host print transform in non-graphic mode  43 
TN5250 Printing Session 44 
¾To set values for non-host print transform in non-graphic mode  44 
¾To enable host print transform  45 
Defining the margins 45 
¾To define the margins  46 

Tabs Properties Page 46 
¾To define tab parameters  46 

Colors Property Page 46 
¾To define color parameters  46 

Preferences Property Page 47 
¾To define PowerTerm WBT preferences  47 

Step 4: Saving the Terminal Setup 49 
¾To save terminal settings to the current setup configuration  49 
¾To save a terminal setup under a different name  49 

Step 5: Working with the Host 50 
Printing Data 50 
¾To execute a form feed on the printer  50 
¾To execute a line feed on the printer  50 
¾To print accumulated data displayed in the work area  50 
¾To print a session using device naming  50 
¾To print the Terminal Screen  51 

Step 6: Ending a PowerTerm WBT Session 52 
Automatic Closing 52 
¾To define parameters for closing a PowerTerm WBT session automatically  52 

Optional Closing 52 
¾To re-establish communication  53 

User-Initiated Fast Exit 53 

   
 



 
  

6

Step 7: Exiting PowerTerm WBT 54 
¾To exit PowerTerm WBT  54 

SCRIPTS 55 

Script Overview 56 
PSL Types 56 

Using PowerTerm Scripts 57 
¾To create a script file  57 
¾To edit a script file  57 
¾To record a script  57 
¾To run a specific script  58 
¾To run a script at startup  58 
¾To run a script file during a PowerTerm WBT session using Soft buttons  58 
¾To run a script file during a PowerTerm WBT session using the Power Pad  58 
¾To run a script file upon connecting to a host  59 
¾To run individual script commands  59 
¾To activate a recorded script  59 
¾To save a recorded script  59 

A Special PowerTerm WBT PSL Command 60 

MENU REFERENCE 62 

File Menu 63 
Save Terminal Setup 63 
Save Terminal Setup As 63 
Open Keyboard File 63 
Save Keyboard File 63 
Open Power Pad File 63 
Save Power Pad File 63 
Print Screen 63 
Print Setup 63 
Start/Stop Auto Print 64 
Close Print Queue 64 
Form Feed 64 
Line Feed 64 
New Terminal Window 64 
Exit 64 
Exit All Sessions 64 

Edit Menu 65 
Select Screen 65 
Clear Screen 65 
Reverse Screen 65 
Clear History 65 
Copy 65 
Paste 65 
 

   
 



 
  

7

Automatic Copy 65 
Copy Right To Left 65 

Terminal Menu 66 
Setup 66 
PowerTerm Fonts 66 
Fonts 66 
Reset 66 
Online 66 
Hold Screen 66 

Sessions Menu 67 

Options Menu 68 
Keyboard Map 68 
Power Pad Setup 68 
Hide Menu 68 
Hide Buttons 68 
Hide Status Bar 68 
Hide Power Pad 68 

Script Menu 69 
Run Script 69 
Edit Script 69 
Script Command 69 
Start /Stop Script Recording 69 
Pause/Continue Script Recording 69 
Activate Recorded Script 69 
Save Recorded Script 69 

Help Menu 70 
About PowerTerm WBT 70 

   
 



 
  

8

About this Guide 

This guide assumes that you are familiar with basic windowing system conventions and the 
operation of the terminal you intend to emulate. 
 
The PowerTerm WBT User’s Guide, will present a typical PowerTerm WBT workflow. It will 
describe the basic steps how to access remote terminals and start a session with stored parameters 
as well as different options for ending a session. The Terminal Emulation property pages, the 
Power Script Language (PSL), and the Soft Input Panel will also be described. 
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Chapter 

Introduction to PowerTerm WBT 

This chapter presents PowerTerm WBT and its main features. It describes the basic steps for 
users who are familiar with accessing remote terminals. 
 
This chapter includes the following topics: 
 
• What is PowerTerm WBT?, page 10 
• PowerTerm WBT Features, page 11 
• PowerTerm WBT Setup, page 12 
• A Quick Guide Through PowerTerm WBT, page 14  
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What is PowerTerm WBT? 

PowerTerm WBT is a fully functional terminal emulator for Microsoft Windows-Based Terminal. 
It emulates various terminal types, including UNIX, HP, VMS, Tandem, and IBM. PowerTerm 
WBT enables you to connect to a single or to multiple hosts via both network and remote 
connections. PowerTerm WBT’s Session Manager provides quick access to a list of user-
configured sessions. 
 
PowerTerm WBT provides two main features to enable the WBT to act and feel like a real host 
terminal: 
 

Terminal display emulation • 

• 

• 

• 

• 

PowerTerm WBT emulates the exact display of the chosen terminal. It presents host 
applications exactly as they would appear on the terminal. Once the WBT connects to a host 
computer, all host operations can be performed as if the WBT is an actual host terminal. 
Terminal keyboard emulation 
PowerTerm WBT enables you to emulate the selected terminal’s keyboard by mapping the 
WBT keys to match the host keys. Keyboard mapping definitions are stored in the registry. 

 
PowerTerm WBT also provides various options to customize and optimize the working 
environment such as: 
 

Power Pad  
A programmable floating keypad. 
Soft buttons  
Programmable buttons located at the bottom of the PowerTerm WBT window. 
Power Script Language (PSL) 
A special programming language, which enables you to create scripts for automating tasks. 
For example, you can create a PSL script for automatic login. Scripts can be used at startup of 
PowerTerm WBT, or can be utilized any time during a PowerTerm WBT session. PSL is 
intended for users with scripting or programming skills. PSL commands can also be assigned 
to the Soft buttons to enable additional functions with a click. 
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PowerTerm WBT Features  

PowerTerm WBT features include: 
 

Compact, light and high performance program. • 
• 
• 
• 
• 
• 
• 
• 
• 
• 
• 
• 
• 
• 
• 
• 

Supports TCP/IP WinSock. 
Supports RS-232. 
Power Script Language (PSL). 
Session Manager. 
Macro recorder for automation of tasks. 
String functions, including sub string, index and concatenation. 
Enables you to save parameters for all sessions. 
Language support for all Western European languages. 
User programmable buttons. 
Floating Power Pad with programmable buttons. 
Control of color selection and screen attributes. 
Easy to use keyboard mapping. 
SCS Printer emulation. 
Online help (only upon request). 
Setup replication. 

 
 
 
 
 
 

   
 



 
  

12

PowerTerm WBT Setup 

To enable PC-host interaction, you need to define two sets of parameters:  
 

Terminal parameters  • 
• Communication parameters 
 
These are both saved in the registry.  
PowerTerm WBT provides the option to work with a single host or with multiple hosts. You can 
create different setup configurations for working with each host to enable each user a customized 
working environment. Each one is saved in the registry. 
 

Working with a Single Terminal Connection 

When you launch PowerTerm WBT from the Connection Manager, it automatically uses the 
parameters in the setup configuration that you choose. 

Working with Multiple Terminal Connections 

If you are working with different terminals with different emulations, you may need to use a 
different setup for each emulation. To create a specific setup, you first need to create a new 
session (with its communication parameters) using the PowerTerm WBT wizard within the 
Connection Manager. After this is accomplished, you launch this newly created session and 
define the terminal setup and save it. These setups will reside in the registry from where they will 
be loaded from now on upon launching the session. 
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Session Manager 

The Session Manager provides quick access to a list of user-configured sessions. You determine 
which of the Non-Activated Sessions you want to activate. Each activated session is represented 
by an icon in the toolbar, thus allowing for quick session access, bringing an active session to the 
foreground, or closing an active session.  
 

¾ 

1 
2 

3 

4 

¾ 

1 
2 

To activate all or some of the sessions: 

Click Session Manager icon. The PowerTerm WBT Session Manager dialog appears. 
Select the desired session from the Non-Activated Sessions list and click on the arrow 
pointing right. The selected session appears in the Sessions To Be Activated list. 
Repeat if desired for the whole Non-Activated Sessions list. You can also remove 
sessions from the Sessions To Be Activated list by clicking the arrow pointing left. 
Click OK. All the sessions in Sessions To Be Activated list are activated. 

N
 

OTE Pay attention to notifications displayed at the bottom of the dialog box. 
 
 

 
To deactivate (close) a session: 

Select the session to deactivate from the Session menu list or click its icon on the toolbar.  
Click the close button (X). The session is deactivated. 

   
 



 
  

14

A Quick Guide Through PowerTerm 
WBT 

The following workflow provides a quick guide for using PowerTerm WBT: 

 
 
Each of the steps is explained on the pages that follow.  

Step 1: Define a Connection Entry 

¾ 

1 
2 
3 

4 
5 
6 
7 

To define connection parameters: 

From the Terminal Connection Manager, select the Configure tab. 
Click Add to create a new session. The New Connection dialog box appears. 

N
Select Ericom PowerTerm WBT - Terminal Emulator. 

 
OTE The exact name depends on the OEM. 
 
 

Click OK. The Connection Properties dialog box appears. 
Supply the IP address or Host Name. 
Select the desired Terminal Type and ID. 
Type the Terminal Name if necessary. 
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Modify the Port # if necessary. 8 
9 
10 

¾ 

1 
2 

• 
• 

¾ 

• 

Type the Connection Name. This name automatically appears in the Setup Name field. 
Click OK. The new connection appears in the Connection Name list of the Connection 
Manager. 
 

NOTE The above-mentioned parameters are for Telnet only. For other 
communication protocols, different required parameters may exist. 

 
 

Step 2: Connect to Host 

You can either select to connect to the terminal session you have just defined or connect to a 
previously defined connection. 
 
To connect to host: 

From the Terminal Connection Manager, select the Connections tab. 
Select the desired session and press Connect. 
Or, 
Double-click on the selected session. 

 
After the connection is established you can define the terminal settings in the following way: 

• Select Terminal  | Setup. The Terminal Setup dialog box is displayed. 

Step 3: Work with a Host 

PowerTerm WBT also provides a printing option where you can define print 
parameters, and print the terminal screen or data transferred from the host 
application. 

Step 4: Exit PowerTerm WBT 

PowerTerm WBT provides options when exiting PowerTerm WBT: 
End a session automatically, or 
Be prompted with a confirmation message prior to closing a session. 

 
To exit PowerTerm WBT: 

Select File | Exit. The PowerTerm WBT window closes. 
If you have changed terminal settings, PowerTerm WBT displays a warning message asking 
if you want to update the terminal settings saved in the registry. The message will point to the 
name of the setup configuration currently loaded. Click OK to update the terminal settings, or 
No to cancel the latest changes and restore the default setup. 
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Chapter 2:  

 

Chapter 

 

The PowerTerm WBT Work Area 

This chapter provides an overview of the PowerTerm WBT window and its components. The 
PowerTerm WBT window contains menu options that provide access to most PowerTerm 
functions. The most important feature of the PowerTerm WBT window is its work (client) area, 
which emulates a host terminal screen by displaying data entered on your terminal, and data 
received from the host.  
 
This chapter describes the following topics: 
 

The PowerTerm WBT Window, page 17 • 
• 
• 
• 
• 
• 

Menu Bar, page 18 
PowerTerm WBT Toolbar, page 19 
Hot Keys, page 21 
Manipulating Desktop Components, page 22 
Selecting Text, page 24 
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The PowerTerm WBT Window 

The PowerTerm WBT window consists of the following components: 
 
Menu Bar Contains dropdown menus, which enable the user to perform 

most PowerTerm WBT operations.  
 

Work Area Displays the data entered on the device terminal or received 
from the host. During an emulation session, this work area 
emulates a terminal display. For IBM terminal types, the work 
area is displayed in black. 
 

History Scroll Bar Enables you to scroll up and down through the PowerTerm 
WBT window to view previously displayed data. Default: 
displayed.  
For non-IBM emulations only. 
 

Cursor Position Counter Displays the current line and column position of the text cursor 
in the work area. 
 

Caps Indicates whether the keyboard is in Caps lock mode. 
 

Hold Indicates whether the screen is in hold (frozen) mode. 
 

Soft Buttons Area Contains a series of buttons that you can program to execute 
specific script commands.  
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Menu Bar 

The PowerTerm WBT Menu bar displays the main PowerTerm WBT functions in dropdown 
menus. The following is a brief description of each PowerTerm WBT menu and the functions that 
it can perform. For a more detailed description of each menu option, see Chapter 5, “Menu 
Reference”, page 62. 
  
File Menu Provides options to create, save and restore a terminal setup file 

as well as to open a new instance of the PowerTerm WBT 
window.  
The File menu also enables you to save your keyboard and Soft 
buttons settings and open them at a later date. 
 

Edit Menu Provides options to select, clear, and reverse text in the 
PowerTerm WBT window as well as delete the contents of the 
history buffer.  
The Edit menu also provides standard windowing operating 
system commands (cut, copy and paste), in addition to 
commands that enable you to copy data to a file or to the 
Clipboard. 
 

Terminal Menu Provides options to define and reset connection (terminal and 
communication) parameters, set the system to be online or 
offline, and freeze or unfreeze the screen.  
You can also select the fonts and languages (in versions that 
support it) to be displayed in the PowerTerm WBT window. 
 

Options Menu The Options menu provides various alternatives to customize 
your screen. It enables you to choose the size of your Power 
Pad and how to map your keyboard mapping. It also allows you 
to hide or show the menu, buttons, and status bar.  
 

Script Menu Provides commands designed to write scripts in PowerTerm 
Script Language (PSL) and to run them. 
 

Help Menu Provides options for accessing the PowerTerm WBT product 
information and License extension. 
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PowerTerm WBT Toolbar  

The PowerTerm WBT Toolbar contains tools (buttons), which provide shortcuts to frequently 
used menu options. 
 
The following is a brief description of the tools in the PowerTerm WBT toolbar: 
 
Hold Screen/Release Hold 

 
Freezes and unfreezes the PowerTerm WBT window. 
After you click on the Hold Screen tool, the STOP 
button turns red. After you click on the tool again, the 
STOP button changes to green, and the PowerTerm 
WBT window unfreezes.  
Equivalent to Terminal | Hold Screen.  
Non-IBM emulations only. 
 

Cut 

 
Cuts the selected text. 
5250 emulations only. 
 

Copy To Clipboard 

 
Copies the selected data displayed in the PowerTerm 
WBT work area to the Clipboard.  
Equivalent to Edit | Copy. 
 

Paste From Clipboard 

 
Pastes data from the Clipboard to the host application. 
Equivalent to Edit | Paste. 
 

Print 

 
Prints selected text from the history buffer or the entire 
contents of the work area. 
Equivalent to File | Print Screen. 
 

Start/Stop Auto Print 

 
Prints incoming data as it is displayed on the screen. 
After clicking the tool again, the automatic printing 
stops. 
Equivalent to File | Start Auto Print.  
 

Start/Stop Script Recording 
 

Records manual operations in script form. After clicking 
the tool again, the script recording stops. 
Equivalent to Script | Start Script Recording.  
 

Change To 80 Columns 

 
Specifies an 80-column display for the PowerTerm WBT 
work area.  
Equivalent to Terminal | Setup | Display. 
VT emulations only. 
 

Change To 132 Columns 

 
Specifies a 132-column display for the PowerTerm WBT 
work area.  

   
 



 
  

20

Equivalent to Terminal | Setup | Display. 
VT emulations only. 
 

Terminal Setup 

 
Displays the Terminal Setup dialog box in which you 
can define terminal setup parameters. 
Equivalent to Terminal | Setup. 
 

Keyboard Mapping 

 
Opens the Keyboard Mapping Dialog box in which you 
can map PC keys to host keys.  
Equivalent to Options | Keyboard Map. 
 

Show/Hide Power Pad 

 
Displays the Power Pad. After clicking the tool again, 
the Power Pad dialog closes. 
Equivalent to Options | Show Power Pad.  
 

Help Contents 

 
Displays product information. 
(Optional - only upon Request: Displays the PowerTerm 
WBT online help.) 
Equivalent to Help | Contents. 
 

Session Manager 
 

Provides quick access to a list of user-configured 
sessions. 
 

Session 
 

Displays an icon with an identifiable letter for each 
additional session of PowerTerm WBT. 
Equivalent to pressing <Ctrl>+<Shift>+the desired 
session’s letter. 
 

¾ 

• 

To display a description of what each button does: 

Place the cursor over a tool button. A box appears displaying the tool button's description. 
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Hot Keys 

Hot keys are keyboard keys that you can press instead of choosing menu commands. These hot 
keys refer to your standard PC keyboard keys, before they are mapped to terminal keys. Once hot 
keys are mapped, they lose their original function and reflect the newly mapped terminal key. For 
example, if you map <Alt F4> to the <Backspace> key on the terminal keyboard, it performs the 
function of a <Backspace> key. 
 
The following table lists the default PowerTerm WBT hot keys:  
 
Alt F4 Exit. 

 
Alt F9 Activate script. 

 
Ctrl + Alt F9 Start/stop script recording. 

 
Alt F10 Select screen. 

 
Alt F11 Clear screen. 

 
Alt F12 Reverse screen. Excluding 5250 emulations. 

 
Scroll Lock Hold screen. 

 
Pause Change the cursor shape. 

 
Ctrl Up Arrow Scroll up one line. 

 
Ctrl Down Arrow Scroll down one line. 

 
Ctrl Home Scroll to the beginning of the history buffer. 

 
Ctrl End Scroll to the end of the history buffer. 

 
Ctrl Page Up Scroll up one page. 

 
Ctrl Page Down Scroll down one page. 
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Manipulating Desktop Components 

PowerTerm WBT enables you to customize the PowerTerm WBT window by displaying or 
hiding desktop components and changing the display colors for different text attributes. The color 
attributes change according to the emulation type you have selected. 
 
Most components are displayed or hidden according to your selection in the Options menu. An 
alternative way is to use a floating menu with all the options. 
 

¾ 

• 

¾ 

• 
• 

• 

¾ 

• 
• 

¾ 

• 
• 

¾ 

• 
• 

¾ 

To open the floating menu: 

Press <Ctrl> + <Alt> + M and select the desired action. 
 
To show/hide the Menu bar: 

Select Options | Hide Menu. This conceals the menu bar. 
Press <ALT> + <Ctrl> + M, and select Restore Menu. The Menu bar is shown again. 
Or, 
Map a Soft button with the following PSL command: 
menu restore. 

 
To show/hide the Soft buttons: 

Select Options | Hide Buttons. The menu option becomes Show Buttons. 
Select again to redisplay the Soft buttons bar. 

 
To show/hide the Status bar: 

Select Options | Hide Status Bar. The menu option becomes Show Status Bar. 
Select again to redisplay the Status bar. 

 
To show/hide the Power Pad: 

Select Options | Show Power Pad. The menu option becomes Hide Power Pad.  
Select again to hide the Power Pad. 

 
To show/hide the History Scroll bar: 

 

NOTE This option is only available for non-IBM emulations. 
 
 

1 
2 
3 
4 

• 

Select Terminal | Setup. The Terminal Setup dialog box appears. 
Click the Display tab. The Display Property page is displayed. 
Select History Scroll Bar in the General section. 
Click OK. The PowerTerm WBT window is redisplayed with the history scroll bar. 

 
Clear History Scroll Bar to remove the history scroll bar from the PowerTerm WBT 
window. 
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¾ 

1 
2 
3 

4 

5 

6 

¾ 

1 
2 
3 

¾ 

1 
2 
3 

¾ 

1 
2 
3 

To change the display color of the PowerTerm WBT window: 

The color for the Normal attribute determines the color of the entire work area. The box above 
the Select Attribute parameter shows the result of your selections. The Select Attribute of the 
entire screen is generally Normal, for non-IBM emulations.  
 

Select Terminal | Setup. The Terminal Setup dialog box is displayed. 
Click the Colors tab. 
Click the attribute for which you want to define foreground and background colors. 
Notice that the attributes change according to the emulation type you selected previously. 
In the Text area, click the color that you want to apply to the text (foreground) of the 
display. 
In the Background area, click the color that you want to apply to the background of the 
text. The box above the Select Attribute parameter shows the result of your selections.  
Click OK to close the Terminal Setup dialog box and display the PowerTerm WBT 
window in the selected colors. 

 
To disable/enable underline: 

 If data is transmitted with the Underline attribute, you can disable the underline by clearing this 
parameter.  

Select Terminal | Setup. The Terminal Setup dialog box appears. 
Click the Colors tab. 
Select/Clear Enable Underline. 

 
To disable/enable blink: 

You can choose whether to enable blinking of data that which was received from the host with 
the blinking attribute. 

Select Terminal | Setup. The Terminal Setup dialog box appears. 
Click the Colors tab. The Colors Property page is displayed. 
Select/Clear Enable Blinking as desired. 

 
To disable/enable host colors: 

You can choose whether to work with the host colors or with your own (PC) color scheme. 
Select Terminal | Setup. The Terminal Setup dialog box appears. 
Click the Colors tab. The Colors Property page is displayed. 
Select/Clear Disable Host Colors as desired.  
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Selecting Text 

The following are descriptions of specific text selection techniques that you may find useful in 
different emulations. 
 

¾ 

¾ 

• 

• 

¾ 

• 

¾ 

• 

¾ 

• 

¾ 

• 

¾ 

• 

To select a word: 

In the work area, you can select text using the mouse. Clicking a word selects the word.  
 

NOTE If the Automatic Copy option in the Edit menu is active (default), selecting 
text also copies the selection to the Clipboard. 
 

To select a block: 

A block is any rectangular section of the work area. 
VT emulation 

Point to one corner of the block, hold down the <Ctrl> key and drag the mouse to 
the opposite corner of the block. 

3270 and 5250 emulations 
Point to one corner of the block and drag the mouse to the opposite corner of the block you 
want to include in the selection. 

 
To select full lines: 

Point to a line, hold down the <Shift> key and drag the mouse to the last line you want to 
include in the selection. 

 
To select a string: 

Point to the first character that you want to include in the selection. Drag the 
mouse to the last character that you want to include in the selection and release 
the mouse button. 

 
To select the entire screen: 

Select Edit | Select Screen.  
 
To select a menu entry: 

VT emulations only 
Double-clicking a word sends the word to the host followed by an <Enter> 
signal. Use this feature to select a menu entry. For example, if the emulation 
screen displays the menu of an application residing on the host, click a menu 
entry to activate the program that the menu entry represents. 

 
To activate light pen support: 

3270 emulations 
Any double-click on the screen is equivalent to touching the screen with a light pen.
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Using PowerTerm WBT  

Chapter 

 

This chapter provides step-by-step instructions for using PowerTerm WBT and provides a 
detailed explanation of each step. 
 

NOTE If you are familiar with terminal emulations, you may want to follow the 
procedure outlined in “A Quick Guide through PowerTerm WBT”. 
 

This chapter consists of the following topics: 
 
Step 1: Create a Connection Entry, page 26. 
Step 2: Setting Up Your Working Environment, page 30. 
Step 3: Defining Settings for a Terminal Emulation, page 36. 
Step 4: Saving the Terminal Setup, page 49. 
Step 5: Working with the Host, 50. 
Step 6: Ending a PowerTerm WBT Session, page 52. 
Step 7: Exiting PowerTerm WBT, page 54. 
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Step 1: Create a Connection Entry 

¾ 

1 
2 
3 

4 
5 
6 
7 
8 
9 
10 

To define connection parameters: 

From the Connection Manager, select the Configure tab. 
Click Add to create a new session. The New Connection dialog appears. 
Select Ericom PowerTerm WBT - Terminal Emulator. 

N
 

OTE The exact name depends on the OEM. 
 
 

 
Click OK. The Connection Properties dialog box appears. 
Supply the IP address or Host Name. 
Select the desired Terminal Type & ID. 
Type the Terminal Name if necessary. 
Modify the Port # if necessary. 
Type the Connection Name. This name automatically appears in the Setup Name field. 

N
Click OK. The new connection appears in the Connection Name list of the Connection 
Manager. 
 
OTE The mentioned parameters are for Telnet only. For other communication 
protocols, different required parameters may exist. 
 

The connection parameters that you define will only remain active for the current 
session, unless you save them. 

Connection Parameters 

Following is a description of the parameters that can be defined in the Connection Properties 
dialog box: 
 
Session Type Session types differ according to emulation. For example, under 

a VT session you will see TELNET. The different types are 
described in detail on the following pages. For each session 
type, PowerTerm WBT displays a set of session parameters 
(some types have identical parameters). 
 

Setup Name In this parameter you can specify the name of the terminal setup 
file to be opened after communication is established.  
 

Script Name In this parameter you can specify the name of a script to be run 
after communication is established. 
 

Terminal Type Enables you to change the currently supported emulation. 
Selecting terminal type 5250 Display enables you to assign a 
device name to a session. 
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Terminal ID Enables you to change the ID returned by the emulation 

program to the host. 
 

Device Name  For AS/400 session/ 
Enables you to enter the device name for the emulation session 
(maximum: 10 characters). 
When using multiple sessions enter "devicename+" and each 
session will be automatically assigned a new name. For 
example, if the device name entered was John+, then the first 
session will be John1, the second John2 and so on.  
 

LU Name For 3270 emulations. 
In this parameter you can specify the name of the LU name 
(maximum: 8 characters). 
 

Session Types 

TELNET Uses the Telnet protocol over TCP/IP for network 
communication. For this session type, you must specify the 
host computer name or the IP address in the Host Name text 
box. You can also specify the TELNET port number (default 
23).  
The WINSOCK.DLL file must be in the search path. 
 

COM Uses serial communication with the PC's COM ports. For 
this type, you must define the baud rate, port number, parity, 
stop bits and flow control. Optionally, you can specify a 
phone (dial) number. 
 

TN3270 TELNET for 3270.  
Select the Use TN3270E Protocol box if you want to work 
with TELNET SNA extensions. You can also specify the LU 
name of the host (LU name or LU pool). 
 

TN5250 TELNET for 5250. 
 

¾ 

1 

2 

¾ 
1 
2 

To use an existing configuration: 

Click the browse button adjacent to the Setup Name field located in the Connection 
Properties dialog box. The Open Terminal Setup dialog box appears. 
Choose the desired configuration from the Settings List and click OK. 

Modifying Connection Parameters 

To modify connection parameters: 
Exit PowerTerm WBT thereby rendering the current session inactive. 
From the Connection Manager, select the Configure tab. 
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Verify that the desired session is selected. 
Click Edit. The Connection Parameters dialog box appears. 
Modify the settings. 
Click OK. The modified settings are now in effect for the next emulation session. 

Customizing Settings 

The default setup name is the name of the connection. The capability of choosing the customized 
settings is dependent upon whether you saved the settings (see Save Terminal Setup As) with a 
different name when the PowerTerm WBT session is running. 
 
To customize settings: 

From the Connection Manager, select the Configure tab. 
Select the appropriate connection. 
Click Edit. The Connection Properties dialog box appears. 
Click the browse button in the Use Terminal Configuration section. The Open 
Terminal Setup dialog box appears. 
Choose the desired setup either from the: 

Terminal Settings List 
Host (See Import Terminal Setup From Host below.) 

Click OK. The selected name appears in the Setup Name field. 
Click OK. The modified Connection Name now appears in the Connection Name list of 
the Configure tab. 

Import Terminal Setup from Host 

You can import previously defined terminal settings on your PC by using the FTP protocol. 
To import terminal setup from host: 

From the Connection Properties dialog box click the browse adjacent to the Setup 
Name field. The Open Terminal Setup dialog box appears. 
Click From Host. The Import Terminal Setup from Host dialog box appears. 
Type the necessary IP address of the FTP server in the Host Name field. 
Type in the appropriate User Name if necessary. 
Type in the appropriate Password if necessary. 
Type in the appropriate Setup Name if necessary. 
Click OK. The imported Setup Name appears in the Settings List of the Open 
Terminal Setup dialog box. 
Select the imported terminal setup and click OK.  
Fill out all of the necessary fields (Host Name, Connection Name etc.). 
Click OK.  
Select the Connection tab. 
Select the newly defined session and click Connect. 
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Deleting a Connection 

¾ 
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To delete a connection: 

Exit PowerTerm WBT thereby rendering the current session inactive. 
From the Connection Manager, select the Configure tab. 
Verify that the desired session is selected. 
Click Delete. The connection is deleted. 
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Step 2: Setting Up Your Working 
Environment 

This section provides a description of the basic operations that may be performed to set up and 
optimize the PowerTerm WBT working environment for your usage. You can customize the 
PowerTerm WBT window to show or hide window components and change the window’s 
display. These options are all described in Chapter 2:  “The PowerTerm WBT Work Area, 
Manipulating Desktop Components”, page 22. 
 
You can also fine-tune the host application appearance on your screen by: 
 

Adjusting the display settings (number of columns and rows to be shown). • 
• 

• 

• 
• 
• 
• 
• 

¾ 

1 

Specifying a scaled or an unscaled screen. For more information see Step 3: “Defining 
Settings for a Terminal Emulation”, the Display Property page for non-IBM emulations, page 
38, and the General Property page for IBM 3270 and 5250 emulations, page 38. 
Selecting suitable fonts. 

 
PowerTerm WBT enables you to emulate a host keyboard by assigning (mapping) host keys to 
the WBT device keys. You can save your keyboard settings in the registry with a unique name 
and open them at a later date. PowerTerm WBT also provides Soft buttons, which enable you to 
automate commands. 
 

NOTE Whatever changes that you make to the individual features (Keyboard 
Settings, Soft buttons or Power Pad) will not effect the others. For example any 
modifications in Soft buttons will not affect Keyboard settings or Power Pad. 

 
 
To set up the PowerTerm WBT work environment: 
 

Mapping the Keyboard, below 
Saving and Opening Keyboard Mapping Settings, page 32. 
Programming the Power Pad, page 33. 
Saving and Opening Power Pad Settings, page 34.  
Programming Soft buttons, page 34. 

Mapping the Keyboard 

PowerTerm WBT enables you to map WBT keys to host keys in order to emulate the host 
terminal keyboard. Keyboard mapping definitions are stored in the registry with the same name 
as the current terminal setup by default however can be modified. 
 
To map a PC key: 

Select Options | Keyboard Map. The Keyboard Mapping dialog box appears: 
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Drag a key from the upper terminal keyboard to a PC key on the lower keyboard. 2 

• 

¾ 
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• 
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• 

¾ 

• 

• 

 
Click the <Shift> or <Control> keys on the terminal keyboard to display additional key 
functions. For example, if you click the <Shift> key, the alphabet keys on the terminal 
keyboard are displayed in upper case. You can then map (drag) these keys to your PC 
keyboard keys. 

 
To assign a script command to a PC key: 

Select Options | Keyboard Map. The Keyboard Mapping dialog box appears. 
Right-click a key on the PC keyboard that you want to assign a command and select 
Enter Script Commands. The PC Button dialog box appears. 
Enter the desired script commands and click OK. The PC key has now been assigned a 
script command. 

 
To map combinations of keys that include Alt, Ctrl, and Shift: 

Click the <Alt>, <Ctrl> or <Shift> key (or any combination) on your PC keyboard. Then 
map keys by following the procedure described previously. 
Click the required <Alt>, <Ctrl> or <Shift> key (or any combination of these keys), to view 
the mapped key. 

 
To cancel a keyboard key definition: 

Drag the PC key definition that you want to cancel to the wastebasket icon, in the Keyboard 
Mapping dialog box. This restores the default function of the PC key. 

 
To replace a PC key with another PC key: 

PowerTerm WBT enables you to move the functionality of a mapped PC key to another PC key. 
For example, you can drag the F6 key on the PC keyboard to the spacebar on the PC keyboard to 
give it F6 functionality. 

Drag the desired PC key onto the PC key that it will replace, in the Keyboard Mapping 
dialog box. The functionality of the PC key has been replaced.  
Drag the original key back to its initial position. 
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To copy a PC key to another PC key: 

PowerTerm WBT enables you to copy the function of one PC key to another PC key. 
 

Select the PC key whose function you want to copy to the required PC key and right-click 
Copy. 
Select the PC key to where you want to copy the function and right-click Paste. Both 
keys now have the same functionality. 

 
To restore the default keyboard mapping of all mapped keys: 

Click the Defaults button in the Keyboard Mapping dialog box. 

Saving and Opening Keyboard Mapping Settings 

PowerTerm WBT enables you to save keyboard-mapping settings separately in the registry and 
open them at a later date. 
 
To load the keyboard mapping settings: 

Select File | Open Keyboard Setup. The Open Keyboard Setup dialog box is 
displayed: 

 

 
 
Select the required keyboard settings from the list. 2 

3 

¾ 

1 

Click OK. Parameters defined in the selected keyboard settings are now applied to the 
current session. 

 
To save keyboard mapping settings: 

Select File | Save Keyboard Setup. The Save Keyboard Setup dialog box appears: 
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Enter a Keyboard Setup Name.  2 
3 

¾ 

1 

Click OK. The keyboard mapping registry settings are saved with the specified setup 
name. 

Programming the Power Pad 

The Power Pad is a floating keypad that contains buttons, which can be programmed to execute 
customized PSL scripts. You can also change their names and adjust the number of buttons 
displayed in the Power Pad. You can display a maximum of 10 rows and 10 columns in the 
Power Pad. The default number of buttons is 9 rows and 4 columns. 
 
Power Pad buttons are named by default F1, F2, F3, and so on, with a few default function 
names, such as Clear, Enter, and Insert. For example, clicking on the F1 button is equivalent to 
sending F1 to the host. 
 
To program the Power Pad: 

Select Options | Show Power Pad or click  . The Power Pad is displayed. 
Right-click the Power Pad button that you want to program. The Power Pad Button 
dialog box is displayed:  

2 

 

 
 
Enter Button Description (the new name that will appear on the Power Pad button) and 
click OK. The Power Pad Button dialog box is displayed containing a field to enter a 
script command or script commands separated by semicolons. 

3 

4 Enter the Script Command to be run by this Power Pad button. For example, send 
<f13>, and click OK. Clicking on the Power Pad button will execute the newly defined 
script commands, for example, sending <F13> to the host. For more information, see 
Chapter 4: “Scripts”, page 55. 
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¾ 

1 

To adjust the number of buttons in the Power Pad: 

Select Options | Power Pad Setup. The Power Pad Setup dialog box is displayed: 
 

 
 
Click on the dropdown box to select the number of rows or columns that you want the 
Power Pad to contain. 

2 

3 

¾ 

1 

2 
3 

¾ 

1 

2 
3 

Click OK. The Power Pad is displayed with the number of rows and columns specified. 

Saving and Opening Power Pad Settings 

PowerTerm WBT enables you to save your Power Pad settings in separate registry settings and 
open them at a later date. 
 
To save your Power Pad settings: 

Select File | Save Power Pad Setup. The Save Power Pad Setup dialog box is 
displayed. 
Enter a Power Pad Setup Name.  
Click OK. The Power Pad settings will be saved with the specified name. 

 
To open predefined Power Pad settings: 

Select File | Open Power Pad Setup. The Open Power Pad Setup dialog box is 
displayed. 
Select the required Power Pad setup. 
Click OK. Parameters defined in the selected Power Pad setup are now applied to the 
current session. 

Programming Soft Buttons 

 
Along the bottom of the PowerTerm WBT window are twelve programmable Soft buttons, by 
default named from F1 to F12. These can be renamed and programmed to execute customized 
scripts or send individual commands to the host. You send the programmed command to the host 
by clicking the desired Soft button.  
 
Clicking on the F1 Soft button is equivalent to sending F1 to the host. 
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To program Soft buttons: 

Right-click on the Soft button that you want to program. The Function Button dialog 
box is displayed. 
Enter the function description (the new name that will appear on the button) and click 
OK. The Function Button dialog box is displayed with a field to enter a script command 
or script commands separated by semicolons. 
Enter the script command to be run by this button.  
Click OK. The Soft button is now displayed with its new name. Clicking on the Soft 
button will execute the newly defined script command. For more information, see 
Chapter 4: "Scripts, Using PowerTerm Scripts", page 57. 
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Step 3: Defining Settings for a 
Terminal Emulation (Terminal 
Settings) 

PowerTerm WBT enables you to define the terminal settings for connecting to a host. Once you 
have defined terminal settings, you can save them as a setup in the registry. This setup can be 
activated at a PowerTerm WBT startup. You can also create predefined Terminal settings on your 
PC and then copy them to your device. 
 
Each setting option is displayed in the format of a property page in the Terminal Setup dialog 
box.  

N
 

OTE The available settings are according to the selected emulation type.  

 

 
 

The terminal settings provided by PowerTerm WBT:  
 

General, defines parameters for the terminal emulation type, page 36. • 
• 
• 
• 
• 
• 
• 

¾ 

1 
2 
3 

Display, defines display settings for the PowerTerm WBT window, page 38. 
Keyboard, defines keyboard setup parameters, page 40. 
Printer, defines printer parameters, page 42. 
Tabs, defines tab positions, page 46. 
Colors, defines color settings for the PowerTerm WBT window, page 46. 
Preferences, defines parameters that determine PowerTerm WBT behavior and automate 
processes, page 47. 

I
 

MPORTANT The parameters that you define will only remain active for the current 
session, unless you save them in the registry. For more information, see Step 4: 
“Saving the Terminal Setup”, page 49. 

General Property Page 

The General property page enables you to define parameters for the selected emulation type. 
 
To define emulation parameters: 

Select Terminal | Setup. The Terminal Setup dialog box appears. 
Select the General tab. The General property page is displayed. 
Select the parameters that you require.  
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The parameters displayed in the General property page are: 
 
Terminal ID Determines the ID returned by the emulation program to the 

host. Verify that you select an ID that the host 
application/system recognizes. 
 

NRC Set Determines the communication and keyboard character set for 
7-bit data only. You can either select None or one of the 
languages available. 
 

UPS Set Determines the communication and keyboard character set for 
8-bit data only. Select one of the available character sets. 
 

8 bit Controls Enabled when UPS Set is specified as Code Page 437 and up. 
• 

• 
• 

• 

• 

• 

• 
• 

• 

• 

Disable, determines if 0x80 to 0xAF are displayed 
characters. 
Enable, determines if 0x80 to 0xAD are control characters. 
0x9B, all characters are displayed characters except 0x9B, 
which is a control character. 

 
Online Equivalent to Terminal | On Line (Off Line). 

 
New Line Determines whether the <Enter> key generates only a carriage 

return or a carriage return/line feed combination. 
 

Use 8 Bit Data Characters Select this parameter if the communicated data is in 8-bit 
character format. 
Clear it for 7-bit characters. When cleared, the 8th bit is 
truncated.  
If you receive 7-bit data, you can convert it to 8-bit data for 
printing on the slave printer. 

 
User Defined Keys (UDK)  Determines whether applications on the host system can 

override your user-defined keys (UDKs) when you have 
defined a function key that conflicts with how the host wants to 
use this key.  

Locked, prevents UDKs from being overridden.  
Unlocked, allows them to be overridden. 

 
Cursor Keys Determines whether the four arrow keys generate ANSI-

standard control sequences for moving the cursor, or generate 
customized application program functions.  
 

Keypad  Determines the effects of the numeric keypad on your 
keyboard. 

Numeric, keypad keys insert numbers. For example, 
pressing <7> on the numeric keypad is the same as typing 
<7> on the keyboard.  
Application, keypad keys generate control sequences that 
can be used by some applications. 
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Cursor coupling • 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

Vertical, determines whether the user window pans with 
the cursor when the cursor moves past the top or bottom 
border of the user window. 
Page, determines if a new page appears in the display when 
the cursor moves to a new page. 

 
Status Line None, d,isplays an emulation screen without the status line.  

 

Specific parameters for the 3270 and 5250 emulation types: 

General ID, determines the ID returned by the emulation program to 
the host. Make sure you select an ID that the host 
application recognizes.  
Column separator, (5250 only) displays a period as a 
column separator in fields with the column separator 
attribute.  
Show Response Time, displays the number of seconds that 
elapsed between the time data was sent to the host and the 
host response time. 

 
Appearance Unscaled Screen, select this parameter if you want to 

disable the scaleable feature for PowerTerm WBT fonts. 
Power GUI, displays data in a window with 3D look & 
feel. Use System fonts larger than 10 for optimized results. 
Show Frame, places a frame around the text area of the 
emulation. 

 
Cursor Ruler Displays full-screen, vertical or horizontal lines as a cursor 

ruler or no cursor ruler at all. 
 

Cursor Controls the cursor appearance and functionality. 
Block/Underline/Visible/Blink, controls the cursor 
appearance. 
Ins Change, when selected it enables toggling the cursor 
between underline and block appearance, by clicking the 
Ins (insert) button. 

 
Code Page Specifies the host and PC (keyboard) character sets.  

 
Alternate Size Enable, select to override the terminal alternate size with a 

specific size. 
Rows/Columns type the required number. 

 

Display Property Page 

The Display property page enables you to define parameters that determine the appearance 
(display) of the PowerTerm WBT window. 
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NOTE For non-IBM emulations only. 
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• 

• 

To define display parameters: 

Select Terminal | Setup. The Terminal Setup dialog box appears. 
Select the Display tab. The Display property page is displayed. 
Select the parameters that you require. 

  
The parameters displayed in the Display property page are: 
 
General Reverse Display Colors, reverses the text and background 

colors in the work area.  
Unscaled Screen, select this parameter if you want to 
disable the scaleable feature. 
Autowrap Characters, wraps words at the end of a line 
and the cursor moves to the next line. 
History Scroll Bar, displays the vertical history scroll bar 
along the right edge of the PowerTerm WBT screen. This 
enables you to scroll through the data displayed previously 
on the screen. If the host transmits during scrolling, the 
display automatically scrolls back to its current position.  

 
Cursor Ruler Select Visible to display full-screen, vertical or horizontal lines 

as a cursor ruler (cross hair guide). 
No Ruler, does not display Cursor Ruler. 
Horizontal, displays the cursor ruler as a horizontal line 
only. 
Vertical, displays the cursor ruler as a vertical line only. 
Cross Hair, displays the cursor ruler as a horizontal and 
vertical line. 

 
Cursor Controls the cursor appearance and functionality. 

Block/Underline/Visible/Blink, controls the cursor 
appearance. 
Ins Change, when selected it enables toggling the cursor 
between underline and block appearance, by clicking the 
Ins (insert) button. 

 
Ctrl Characters Display, displays the control characters.  

Interpret, displays normal text as affected by control 
characters 
 

Power GUI Displays data in a window with 3D look & feel. Use System 
fonts larger than 10 for optimized results. 
 

Show Frame Places a frame around the text area of the emulation. 
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Dimensions Determines the number of characters (columns) per displayed 
line, and the number of lines to be displayed in the work area. 
Characters are scaled according to the selected values. 
Type a different value in the Other box instead of choosing one 
of the standard options (80 and 132). 
 

Scrolling Determines the pace at which data is displayed in the work area 
as it arrives. If you select Jump, you should determine the 
Jump Scroll Speed that is measured in number of line units. 
The higher the value, the faster the scrolling. 
• 
• 
• 

¾ 
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Unlimited, displays data without delaying communication. 
Page, scrolls data by full screens. 
Smooth, is equivalent to a Jump Scroll Speed of 1. 

 
Enable Soft Fonts Enables you to work with VT soft fonts. The fonts will be 

loaded from the host application. 
 

Keyboard Property Page 

The Keyboard property page enables you to define keyboard parameters for your PC. 
 
To define keyboard parameters: 

Select Terminal | Setup. The Terminal Setup dialog box appears. 
Select the Keyboard tab. The Keyboard property page is displayed. 
Select the parameters that you require. 

 
The parameters displayed in the Keyboard property page are: 
 
Backspace Key Sends Determines whether the <Backspace> key sends Delete or an 

actual Backspace. 
 

Auto Repeat Repeatedly displays the character whose key is being 
continuously pressed down. 
 

Key Click Issues a click sound when you press a key on the keyboard. 
 

Warning Bell Determines whether the terminal sounds a bell tone when 
receiving the "bell" (ASCII 7) character. For operating errors, 
mail messages etc. 
 

Margin bell Determines whether the terminal sounds a bell tone when the 
cursor reaches the right margin. 
 

Numpad Decimal Sends 
Comma 

Determines whether the Numeric Pad sends a comma instead of 
a decimal. 
 

Use Emulator Alt Keys Select to make an <Alt> key perform the terminal operation 
even if Windows OS has an operation mapped to the same key. 
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Local Echo Determines whether keyboard input is displayed (echoed) on 

your screen. 
• 

• 

• 
• 

Select to display the keyboard input even if the host system 
does not echo your input.  
Clear to send the keyboard input to the host system without 
being displayed on the screen (unless the host system 
echoes the characters). 

 
Use VT Keyboard Mode Changes your keyboard into a Digital VT keyboard mode. In 

this mode, the PC keyboard operates as close to a VT keyboard 
as possible, and takes full advantage of LK450 Digital 
keyboards. 
 

Answerback Message Specifies an answerback message and its display. 
Clear, deletes the message. 
Conceal, hides the message without being deleted.. 

 
Auto Answerback Determines whether the terminal automatically sends the 

message to the host system after you make the connection. This 
is useful if your answerback message is a command to the host 
system.  
 

Specific parameters for the 3270 and 5250 emulation types: 

Backspace Deletes Select to delete characters by pressing the Backspace key. 
 

Auto Repeat Repeatedly displays the character for which its key is being 
continuously pressed down. 
 

Key Click Issues a click sound when you press a key on the keyboard. 
 

Warning Bell Determines whether the terminal sounds a bell tone for 
operating errors, mail messages and so on. 
 

Typeahead Types data ahead before the host responds. 
 

Use Shift Lock Simulates Shift Lock. When this parameter is checked, the 
entire keyboard moves to Shift Lock status. For example, if you 
type “a”; the keyboard issues “A”. 
 

Numpad Decimal Sends 
Comma 

Determines whether the Numeric Pad sends a comma instead 
of a decimal. 
 

Use Emulator ALT Keys Select to make an <Alt> key perform the terminal operation 
even if Windows OS has an operation mapped to the same key. 
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Reset Key Clear Capslock If the keyboard is locked, a reset key sequence is generated 
prior to when you click on the tab key to advance to the next 
field. 
 

Printer Property Page 

The Printer property page enables you to define printer parameters for your PC. 
 

¾ 
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• 

• 

• 

• 
• 

To define printer parameters: 

Select Terminal | Setup. The Terminal Setup dialog box appears. 
Select the Printer tab. The Printer property page appears. 
Select the parameters that you require.  

 
The parameters displayed in the Printer property page are: 
 
Print Device Allows you to select a printing output channel.  

None, no destination was assigned. The Device Name is 
disabled. Printer data is received by the terminal, but 
discarded (not printed). 
Device, sends printing to the device you designate in the 
Device Name text box. This can be a device such as PRN, 
IRDA, COM1, etc. In the Device Name text box, you can 
also specify communication parameters. For example: 
COM 1:9600,8. 
Network, sends printing to the network printer. 
You must then perform the following: 
 
1. Select File | Print Setup. 
2. Select Network from Port field. 
3. Type UNC (Universal Naming Convention) in the Net      
Path. 
For example: \\ net1\hp4000 

 
Device Name IRDA, Infrared Standard printer 

COM 1-5, Serial printer 
 

Use Form Feed Adds a form feed (page eject) after each printing job. 
This depends upon the available connections on your PC/WBT. 
 

Print Line Graphics As Text Converts line graphics to text. This speeds up printing on a 
slow dot-matrix printer. 
 

CR->CRLF Adds a line feed after each single carriage return (one that has 
no line feed following it) when in slave printing mode. 
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Print Screen Data 
Conversion 

Converts data to IBM or Digital character sets or prints in 
Graphics mode. 
• 

• 

• 

• 

¾ 
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None, does not convert data. 
 

Slave Printer Data 
Conversion 

Converts data to IBM or Digital character sets or prints in 
Graphics mode for slave printing. 

None, does not convert data.  
 

Slave Printer Job  Specifies the job delimiter character that will divide the data 
into print jobs, thus disabling the escape sequences arriving 
from the host application. 
Non-IBM sessions only. 
 

Delay for Print Closing The command to close the printer queue is delayed by the 
number of seconds that you determine. This command only 
takes effect if no open command is issued in the meantime. 
Important for printing to cut sheet printers (for example, 
inkjets/lasers) and network printers. 
 

Advanced Printing 

The Advanced Printer Setup dialog box enables you to define additional printer parameters. 

Non 5250 printing 

There are two different modes with different fields enabled: 
Text mode is designated in the Printer property page by setting the two data conversion 
combo boxes (Print Screen and Slave Printer) to None. 
Graphics mode is graphic printing. 

 
To set values for non-host print transform in non-graphic mode: 

Select the Printer property page. 
Click the Advanced Printing button. The Advanced Printer Setup dialog box appears. 
Select your printer model, or a compatible one, from the Printer/Type Model drop down 
list. 
Use the initial printer values that appear in the Font, CPI, LPI, Printer Columns and 
Printer Rows combo boxes or override them by clearing the Ignore check box and 
setting the desired values in the adjacent field. 
Determine the paper orientation (Ignore, Portrait, Landscape). 
Configure the paper Tray for your printing. 
Click OK. 

 
The parameters displayed in Text mode are: 
 
Printer Type Specifies the destination printer. 

 
Ignore Disables the adjacent field. When selected, default values are 

applied. 
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Font Printer default font and size will be applied to the output when 

Ignore is selected. Otherwise, User input will be applied. 
Select the desired font from the Font dropdown list. 
 

LPI Lines Per Inch 
 

CPI Characters Per Inch 
 

Printer Columns Determines the number of printer columns in the output.  
Select Ignore to apply the number of columns on your emulation 
screen to the output. For graphic printing only. 
 

Printer Rows Determines the number of printer rows in the output.  
Select Ignore to apply the default values of the specific 
emulation to the output. For graphic printing only. 
 

Tray Designates the tray where you want the printer output to arrive. 
 

Orientation Specifies the orientation of the printed output. The default 
depends on your printer’s settings. Options are: 
• 
• 
• 

• 
• 
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Ignore 
Portrait 
Landscape 

 
 
Graphics mode parameters: 
 

Printer Columns and Printer Rows are the only relevant fields. 
Select the desired Orientation in the Print Setup dialog box. 

 

TN5250 Printing Session 

To set values for non-host print transform in non-graphic mode: 

Select the Printer property page. 
Click the Advance Printing button. The Advanced Printer Setup dialog box is 
displayed. 
Select your printer model, or a compatible one, from the Printer Type / Model drop 
down list.  
Use the host values for the Font, CPI, LPI, Printer Columns and Printer Rows or 
override them by clearing the Use Host Value check box and selecting the desired value 
from the adjacent fields. See the above explanations concerning these parameters. 
Determine the paper orientation (Ignore, Portrait, Landscape). 
Configure the paper Tray for your printing. 
Click OK. 
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To enable host print transform: 

NOTE For 5250 printer session only. 
 
 

 
Select Enable Host Print Transform. 
Select the manufacturer printer type and model from the Printer Type/Model dropdown 
list. 
Select the paper size from the Drawer 1 dropdown list. 
Select the paper size from the Drawer 2 dropdown list. 
Select the paper size from the Envelope Hopper dropdown list. 
Specify whether the printer has Code Page 899 installed in the Supports ASCII Code-
Page 899 check box. 

 
Additional settings for Other Printers: 

Specify the Customizing Object. 
Specify the Customizing Object’s Library. 

 
The parameters displayed are: 
 
Enable AS/400 Host Print 
Transform 

Enabled, pass through (transparent) mode. The host sends 
(ASCII) command and text directly to the printer. Non-graphic 
printing only. 
Disabled, the host sends (EBCDIC) 5250 SCS format 
commands and text to the emulation. The emulation in turn, 
translates to printer specific commands.  
 

Customizing Object Specifies the object name that you have previously defined on 
the AS/400. 
Enabled only for "Other" Printer model. 
 

Drawer 1 Specifies the size for the paper in Paper Source 1. 
 

Drawer 2 Specifies the size for the paper in Paper Source 2. 
 

Envelope Hopper Specifies the size of the envelope. 
 

Supports ASCII Code-Page 
899 
 

Specifies whether the printer has Code Page 899 installed. 
 

Library Specifies the customizing object’s library on the AS/400. 
Enabled only for "Other" Printer model. 
 

 

Defining the margins 

Margins of the print output can be customized according to your specific needs. 
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To define the margins: 

Select File. 
Select Print Setup. The Print Setup dialog appears. 

N
 

OTE Margins settings are only relevant when Data Conversion type = 
Graphics. When Ignore is selected (the default printer values are used) for 
CPI, then the right margin field is enabled. When this value is selected for LPI, 

the bottom margin field is activated. 

Tabs Properties Page 

The Tabs properties page enables you to determine tabs in the work area. Tabbed data received 
from the host will be laid out in the work area according to ruler settings defined with this option. 

N
 

OTE This option is only displayed for VT terminal types. 
 
 

To define tab parameters: 

Select Terminal | Setup. The Terminal Setup dialog box is displayed. 
Select the Tabs tab. The Tabs properties page is displayed. 
Select the tab parameters that you require. 

 
The parameters displayed in the Tab property page are: 
 
Tab Stops Click anywhere within the Tab Stops area to set tab stops 

manually. 
Set Every, sets a tab stop in increments of a number typed 
in the adjacent text field.  
Clear All, clears all tab stops. 

 

Colors Property Page 

The Colors property page enables you to define the color of data displayed in the work area.  
 
To define color parameters: 

Select Terminal | Setup. The Terminal Setup dialog box appears. 
Select the Colors tab. The Colors property page is displayed. 
Select the parameters that you require. 

 
The parameters displayed in the Colors property page are: 
 
Preview Box Shows the result of your selections.  

 
Enable Underline Enables underlined characters.  

Clear to disable displaying data with the underline, for data 
transmitted from the host with the Underline attribute. 
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Enable Blink Enables blinking. 

Clear to disable blinking data, for data transmitted from the host 
with the Blink attribute. 
 

Disable Host Colors Select to ignore specific color assignment by the host. Uses 
colors you select for the attributes only. 
 

Select Attribute Select the attribute for which you want to define foreground 
and background colors. Attributes change according to the 
emulation type you selected in the Emulation property page. 
Generally, the attribute of the entire screen is Normal. The 
color for the Normal attribute determines the color of the entire 
work area. 
 

Text Select the color that will apply to the text (foreground) of the 
display. 
 

Background Select the color that will apply to the background of the text. 
 

Preferences Property Page 

The Preferences property page enables you to determine PowerTerm WBT behavior and 
automate processes. They remain active until you change them. For example, if you select to 
connect automatically at PowerTerm WBT startup, you will always be connected when you open 
PowerTerm WBT, until you change this setting in the Preferences property page. 
 

¾ 

1 
2 
3 

• 

• 

• 

• 

To define PowerTerm WBT preferences: 

Select Terminal | Setup. The Terminal Setup dialog box appears. 
Select the Preferences tab. The Preferences property page is displayed. 
Select the parameters that you require. 

 
The parameters displayed in the Preferences property page are: 
 
History Buffer Specifies the size of the buffer in which data is stored, by 

selecting an option from the dropdown list. 
 

On PowerTerm WBT Exit Save Terminal Setup, the new terminal parameters (if you 
changed them) are saved to the current terminal setup file. 
Confirm Save, terminal parameters are not saved 
automatically. PowerTerm WBT displays a dialog box 
where you can decide whether or not to save.  
Confirm Disconnect Session, if you close PowerTerm 
WBT during a session, you will be requested to confirm 
disconnect. 
Inactivity Timeout, specifies the time limit for keyboard 
inactivity, after which time PowerTerm WBT shuts down. 
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On Session Exit • 

• 

Auto Reconnect, re-establishes communication if the line 
was dropped. 
Auto Exit PowerTerm WBT, closes PowerTerm WBT 
altogether on disconnect. 
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Step 4: Saving the Terminal Setup 

Once both terminal and communication settings have been defined, you can save them in the 
registry. These settings can be used to start PowerTerm WBT, or can be modified manually 
during a PowerTerm WBT session. 
You have the option of saving the file with a different name than its current name by selecting 
Terminal Setup As. Otherwise, the Save Terminal Setup option will save the current terminal 
settings under its present name in the registry.  
 

¾ 

¾ 

1 

To save terminal settings to the current setup configuration: 

• Select File | Save Terminal Setup. The current terminal settings are saved to the registry. 

NOTE This option overwrites parameters previously defined in the setup 
configuration. 

 
To save a terminal setup under a different name: 

Select File | Save Terminal Setup As. The Save Terminal Setup dialog box is 
displayed: 

 

 
 
Type in the desired Terminal Setup Name. 2 

3 Click OK. The file will be saved in the registry. 
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Step 5: Working with the Host 

Once you have connected to a host, PowerTerm WBT enables you to work as if you are working 
from a terminal, and enables you to print data from your host application or to print the terminal 
screen. 

Printing Data 

PowerTerm WBT enables you to define print parameters and print the terminal screen or data 
transferred from the host application. 
 

¾ 

¾ 
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To execute a form feed on the printer: 

• Select File | Form Feed. 
 
To execute a line feed on the printer: 

• Select File | Line Feed. 
 
To print accumulated data displayed in the work area: 

Select File | Start Auto Print. The Start Auto Print command starts accumulating 
incoming data (while it is displayed on the screen). After you select this command, the 
menu option changes to Stop Printing.  
Select File | Stop Printing. The Stop Printing command prints all the data accumulated 
in the printing buffer of the slave printer, or in the autoprint buffer. If data was buffered 
with a printing request and communication failed before the data was sent to the slave 
printer, select this command to print the accumulated information. 

 
To print a session using device naming: 

Create a connection entry under Configure tab in the Terminal Connection Manager. 
Enter the name of the AS/400 host (5250) in the Host Name field.  
Enter the name of the device for the printer session, in the Device Name field. 
Connect to a host under the Connections tab in the Terminal Connection Manager. 
Select Terminal | Setup. The Terminal Setup dialog box appears. 
Select the Printer tab, and from the Print Device dropdown list select Device. 
Enter your print communication port in the Device Name field and click OK.  
For example LPT1: in the event that your printer is connected to the LPT1 port. 
Select File | Save Terminal Settings.  
Select File | Exit. 
Connect to a host. A gray emulation screen, which displays the slave printer data, 
appears.  
Leave it open. The AS/400 automatically creates a queue with the specified device name. 
Open another pre-defined 5250-display session using the Session Manager, and send 
your print jobs to the queue created by the AS/400. 
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To print the Terminal Screen: ¾ 

• Select File | Print Screen to print screens in the history buffer, or the entire contents of the 
work area. 

N
 

OTE In order to print selected text it must appear in the History buffer. 
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Step 6: Ending a PowerTerm WBT 
Session 

You need to end the session(s) before exiting the PowerTerm WBT application. PowerTerm 
WBT provides four options to end a session: 
 

Automatic Closing, below. • 
• 
• 

¾ 
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4 

• 
• 

Optional Closing, below. 
User-Initiated Fast Exit, page 53. 

Automatic Closing 

You can close PowerTerm WBT automatically when you close a session. 
 
To define parameters for closing a PowerTerm WBT session 
automatically: 

Select Teminal | Setup. The Terminal Setup dialog box is displayed. 
Select the Preferences tab. 
Select Auto Exit PowerTerm WBT.  
Click OK. 

 
If you have modified terminal parameters during a session, a message displays asking if you want 
to save the setup configuration before closing. 

N
 

OTE To automatically reconnect a PowerTerm WBT session when you exit 
the current session, select the Auto ReConnect option On Session Exit 
in the Terminate Setup dialog box. 

Optional Closing 

NOTE For non-IBM emulations only.  
 
 

 
PowerTerm displays the following message at session termination when Auto Exit PowerTerm 
in the Terminal Setup dialog box is cleared: 

“Session closed (<exit code>). Hit Enter to restart session.” 
 
<exit code> may have one of the following values: 

Zero (0), communication ended successfully. 
Any number (other than 0), communication aborted. The exit code points to the error that 
caused the problem. 
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• 

• 

To re-establish communication: 

Press Enter to re-establish communication based on the current terminal and communication 
parameters. 

User-Initiated Fast Exit 

If you request a fast exit while communication is in progress (for example, by pressing <Alt> + 
X), PowerTerm WBT reacts according to the parameters that you selected in the Preferences tab 
of the Terminal Setup dialog box.  
If you have selected the Auto Exit PowerTerm WBT parameter, PowerTerm WBT closes the 
session and exits. If this parameter is not selected, a message is displayed enabling you to decide 
what to do next. 

To access the Preferences tab, select Setup from the Terminal menu. 
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Step 7: Exiting PowerTerm WBT  

¾ 

• 

To exit PowerTerm WBT: 

Select File | Exit (Alt+F4) or click on the exit button in the top right-hand corner. 

N
 

OTE If you have changed the terminal settings, PowerTerm WBT displays a 
warning message asking if you want to update the terminal settings. The 
message will point to the name of the setup configuration currently loaded. 

  Click OK to update the setup configuration, or No to cancel the latest  
  changes and restore the default setup. 
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Chapter 

 

Scripts 

PowerTerm WBT enables you to create scripts for automating tasks. The Power Script 
Language (PSL) is PowerTerm WBT’s own programming language. This chapter describes how 
to create, edit, run, save and activate scripts in PowerTerm WBT.  
 
For a full description of the different PSL commands, see the “PowerTerm Power Script 
Language, Programmer’s Reference”. 
 
This chapter describes the following topics: 
 

Script Overview, page 56 • 
• 
• 

Using PowerTerm Scripts, page 57 
A special PowerTerm WBT PSL Command, page 60. 
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Script Overview 

PowerTerm WBT enables you to use scripts to automate tasks. For example, you can create a 
script to login to a PowerTerm WBT session, execute a file, display a message, etc. Scripts can be 
run upon startup or during a PowerTerm WBT session. They can be written in any standard text 
editor, like Notepad and are saved with a .PSL extension.  

PSL Types 

The PSL commands can be grouped into different categories: 
 
Simulation transmission to 
host commands 
 

Enables you to communicate with the host. For examples, the 
<send> command sends data to the host. 

Standard programming 
commands 
 

Enables you to use standard programming commands. For 
example, the <exec> command opens a program. 

File handling commands Enables you to work with files. For example, the <read> 
command reads from a file. 
 

PowerTerm WBT-specific 
commands 

Enables you to activate specific PowerTerm WBT features. For 
example, the <map> command enables you to map a PC key to 
a host key. 
 

Desktop interface commands Enables you to manipulate components in the PowerTerm WBT 
window. For example, the <menu hide> command hides the 
PowerTerm WBT menu. 
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Using PowerTerm Scripts 

PowerTerm WBT provides you with the following script options: 
 

Create a Script, creates a script to run upon startup or at any time during a PowerTerm WBT 
session. 

• 

• 
• 
• 

• 

• 
• 
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Edit a Script, edits an existing script file. 
Script Command, runs a specific command instantly. 
Record a Script, creates a script by recording all the actions that you perform in the 
PowerTerm WBT window. Actions can include selecting a menu option, typing an entry on 
the screen, making selections in a dialog box, and so on. 
Run Scripts, runs specific scripts or individual command, upon startup or during a 
PowerTerm WBT session, to automate specific tasks. You can only run saved scripts. 
Activate a recorded Script, executes a non-saved script from the current memory. 
Save a recorded Script, saves your scripts to be used at a later date. 

 
To create a script file: 

Select Script | Edit Script. The Script Editing dialog box appears 
Type a name for the new script in the text box to the right of the New button. 
Click Add. The PowerTerm WBT Script Editor appears. 
Type the script and click Save from the File menu to save your new script. The next time 
you run or edit a script, this new file will appear in the Scripts List. 
Select File | Exit to exit the PowerTerm WBT Script Editor. 

 
To edit a script file: 

Select Script | Edit Script. The Script Editing dialog box appears. 
Select the required script file in the files list.  
Click OK. The PowerTerm WBT Script Editor appears. 
Edit the script and click Save from the File menu to save your changes. 
Click Exit from the File menu. 

 
To record a script: 

Click  or select Script | Start Script Recording. The Start Script Recording option 
changes to Stop Script Recording. 
Perform the manual operations that you want to record. For example, select a menu 
option, enter parameters in a dialog box, or type a password. 

2 

3 

4 

5 

Select Script | Pause Script Recording if you do not want to record certain operations. 
The script recording process pauses and the menu option changes to Continue Script 
Recording. 
Select Script | Continue Script Recording to resume script recording. 
Select Script | Stop Script Recording or click  when you have performed all the 
operations to be stored in the script. 
You can also save the script file that you created, so that you can run it at any time to 
repeat the operations.  
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To run a specific script: 

Select Script | Run Script. The Run Script dialog box, which lists all the scripts in the 
registry, appears: 
 

  
 

2 
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Double-click the script that you want to run. The selected script is executed. 
 
To run a script at startup: 

From the Terminal Connection Manager, select the Configure tab. 
Select the appropriate connection and click Edit or simply double-click on it. The 
Connection Properties dialog box appears. 
Select Run Script. The Script Name edit box is enabled. 
Type in the name of the desired Script Name  
Or, 
Click the browse button. The Open Script dialog appears. 

Choose the desired script from the Script List. 
Click OK. The selected name appears in the Script Name field. 

Click OK. The designated script will be activated upon startup of this PowerTerm WBT 
session. 

 
To run a script file during a PowerTerm WBT session using Soft 
buttons: 

Click the Soft button that has the desired script assigned. The script is executed. For more 
information, see Chapter 3, Step 2: “Programming Soft Buttons”, page 34. 

 
To run a script file during a PowerTerm WBT session using the Power 
Pad: 

Click the Power Pad button that has the desired script assigned. The script is executed. For 
more information, see Chapter 3, Step 2: “Programming the Power Pad”, page 33. 
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To run a script file upon connecting to a host: 

Select Communication | Connect. The Connect dialog box appears. 
Type the full path of the desired file in the Script File field 
Or, 
Browse for it. The Browse Login Script dialog appears. 

Locate the desired file and select it. 
Click OK. The selected script file appears in the Script File field. 

Click OK. The designated script is executed upon connection. 
 
To run individual script commands: 

Select Script | Script Command. The Script Command dialog box appears: 
 

 
 
Type the name of the script command you want to run. Include parameters, if necessary. 2 

3 

¾ 

¾ 
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Click OK. The specified script command is executed. 
 
To activate a recorded script: 

• Select Script | Activate Recorded Script (<Alt> + <F9>). The 
script currently recorded in memory is now activated. 

 
To save a recorded script: 

Select Script | Save Recorded Script. The Save Recorded Script dialog box appears: 
 

 
 
Enter a script name. 2 

3 Click OK. The script will be saved with the specified name.  
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A Special PowerTerm WBT PSL 
Command 

Activate Connection 
Description 
Opens a session according to communication parameters previously defined in the PT WBT 
connection properties dialog in connection manager. 

Syntax 
Activate-Connection connection-name 
 
connection-name Specifies the name of the desired host connection. 

Returns 
Returns an empty string. 

Examples 
Opens a COM session with the following parameters: 

set comm-type com 
set port-number 2 
set baud-rate 19200 
set protocol-type xonxoff 
Activate-Connection 

 
Modifies the COM session to 9600 baud-rate: 

set baud-rate 9600 
Activate-Connection 

 
Opens the setup file "abc.pts" for working with specific PowerTerm parameters for the "abc" host 
(similar to the Open command on the File menu). Then opens a Telnet session to host "abc" 
(similar to the Connect command on the Communication menu). 

open-setup-file abc.pts 
set comm-type telnet 
set host-name abc 
Activate-Connection 

 
Opens a lat session to host "abc" through DIGITAL PATHWORKS 32: 

set comm-type lat 
set service-name abc 
Activate-Connection 
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Opens a lat session to host "abc" through Novell's NetWare for LAT: 
set comm-type lat 
set server-name NovellServerName 
set service-name abc 
Activate-Connection 
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Chapter 

 

Menu Reference 

This chapter describes each of the PowerTerm WBT Menu bar options. Use it for reference only. 
For a detailed explanation of each step involved, see Chapter 3: “Using PowerTerm WBT”, page 
25. 
 
The PowerTerm WBT Menus are: 
 

File Menu, page 63 • 
• 
• 
• 
• 
• 
• 

Edit Menu, page 65 
Terminal Menu, page 66 
Sessions Menu, page 67 
Options Menu, page 68 
Script Menu page 69 
Help Menu, page 70 
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File Menu 

The File menu provides options to create, save and restore a terminal setup file. You can also 
open keyboard settings and save them as well as open a new instance of the PowerTerm WBT 
window. 

Save Terminal Setup 

Saves the currently opened setup file. Both terminal setup and communication parameters are 
saved to the current setup. 

Save Terminal Setup As 

Opens the Save Terminal Setup As dialog box, which enables you to save the current setup 
configuration under a different name. 

Open Keyboard File 

Opens the Open Keyboard Setup dialog box, which enables you to open keyboard mapping 
settings that have been previously saved in the registry. 

Save Keyboard File 

Opens the Save Keyboard Setup dialog box, which enables you to save separate keyboard 
mapping settings in the registry and open them at a later date. 

Open Power Pad File 

Opens the Open Power Pad Setup dialog box, which enables you to open Power Pad settings 
that have previously been saved in the registry. 

Save Power Pad File 

Opens the Save Power Pad Setup dialog box, which enables you to save Power Pad settings in 
the registry and open them at a later date. 

Print Screen 

Prints the contents of the work area. 

 Print Setup  

Displays the Print dialog box, which contains modifiable printing parameters.  
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Start/Stop Auto Print 

Prints all the data displayed in the work area. This option changes to Stop Printing once the 
Start Auto Print function is activated. Select Stop Printing to stop printing the data displayed in 
the work area. 

Close Print Queue 

Manually closes the print queue. 

Form Feed 

Executes a form feed on the printer. 

Line Feed 

Executes a line feed on the printer. 

New Terminal Window 

Opens the Session Manager, which enables activating a pre-defined terminal session. 

Exit 

Enables you to exit from the current PowerTerm WBT session. 

Exit All Sessions 

Enables you to exit from all PowerTerm WBT sessions. 
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Edit Menu 

The Edit menu provides options to select, clear, and reverse text in the PowerTerm WBT window 
and delete the contents of the history buffer. The Edit menu also provides standard Windows 
editing commands (cut/copy/paste), in addition to commands that enable you to copy data to a file 
and copy data automatically to the clipboard. 

Select Screen 

Selects the contents of the entire work area. 

Clear Screen 

Captures the entire PowerTerm WBT screen and passes the data to the history buffer. An example 
of an application that issues clear screen commands is VMS Mail. 

Reverse Screen  

Reverses the screen. You can type from left to right or right to left, depending on the language 
you are using. 

Clear History 

Deletes the entire contents of the history or scrollback buffer. This command is only available 
when the history buffer is in use. 

Copy 

If the Automatic Copy option in the Edit menu is not active, use the Edit/Copy command to 
copy the marked text to the clipboard. 

Paste 

Pastes the clipboard contents into the work area.  
Right-click (or select Edit/Paste) to send the host data stored in the clipboard. This operation is 
equivalent to actually typing the contents of the clipboard on the host screen. 

Automatic Copy 

Selected text from the work area is automatically copied to the Clipboard. 

Copy Right To Left  

Reverses the order of the letters in the word that was copied to the clipboard when displayed. 
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Terminal Menu 

The Terminal menu provides options to define and reset connection parameters, set the system to 
be online or offline.  

Setup 

Opens the Terminal Setup dialog box in which you can define settings for terminal emulation. 
This dialog box contains different tab pages, which enable you to define all aspects of your 
terminal setup. 

PowerTerm Fonts 

Displays the PowerTerm fonts in the PowerTerm WBT window. 

Fonts 

Provides a selection of system fonts from which to choose. 

Reset 

Resets the VT terminal defaults. This command does not apply to PowerTerm WBT’s exclusive 
terminal parameters (such as color). 

Online 

Sets the system to be online or offline. 

Hold Screen 

Stops communication and freezes the screen. To unfreeze the screen, reselect the command. 
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Sessions Menu 

The Session menu enables you to toggle between sessions. It lists all the active PowerTerm HPC 
sessions. The first session generated is automatically named Session A, the next Session B, and so 
on and so forth. Alternatively you can click the desired session icon on the Session Toolbar. 

   
 



 
  

68

Options Menu 

The Options menu enables you to show or hide PowerTerm WBT window components. The 
Options menu also enables you to display and edit the keyboard and Power Pad mapping and 
define the Power Pad display.  

Keyboard Map 

Displays the Keyboard Mapping dialog box, which enables you to map your PC keys to host 
keys on the terminal keyboard.  

Power Pad Setup 

Displays the Power Pad Setup dialog box, which enables you to adjust the number of buttons 
contained in the Power Pad by specifying the number of rows and columns to be displayed.  

Hide Menu 
Hides the Menu bar.  

Hide Buttons 
Hides the Soft buttons. 
The menu option becomes Show Buttons.  

Hide Status Bar 
Hides the Status Bar. 
The menu option becomes Status Bar.  

Hide Power Pad 
Hides the Status Bar.  
The menu option becomes Show Power Pad.  

N
 

OTE  Press <Ctrl> + <Alt> + M to display a floating menu which offers to 
show/hide menu, buttons, status bar, and Power Pad. 
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Script Menu 

The Script menu provides options to record, edit, and run a script. 

Run Script 

Displays the Run Script dialog box, which enables you to select and run a script. 

Edit Script 

Displays the Edit Script dialog box, which enables you to select the script that you want to edit 
or create a new one. The selected script is opened for editing in PowerTerm WBT Editor. 

Script Command 

Displays the Script Command dialog box, which enables you to run individual script commands. 

Start /Stop Script Recording 

Records a script automatically. After requesting Start Script Recording, the manual operations 
you perform in the emulation screen are recorded into a script file, until you choose the Pause or 
Stop Script Recording command. 

Pause/Continue Script Recording 

Pauses or resumes the script recording. 

Activate Recorded Script 

Activates the script currently recorded in memory. The script is saved in memory while 
PowerTerm WBT session is active until it is saved to the registry with a specific name. 

Save Recorded Script 

Enables you to save a script from memory to the registry with a specific name.  
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Help Menu 

The Help menu provides options for accessing the product information. 

About PowerTerm WBT 

Displays product and contact information.  
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